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Legal Notices

Copyright ©2009, Bio-Rad Laboratories, Incorporated. All rights reserved. Reproduction in any form, either print or electronic, is 

prohibited without written permission of Bio-Rad Laboratories, Inc.

Notice to Purchaser

This base unit, Serial No. ____________, in combination with its immediately attached Bio-Rad sample block module(s), constitutes 

a thermal cycler whose purchase conveys a limited non-transferable immunity from suit for the purchaser’s own internal research 

and development and for use in human in vitro diagnostics and all other applied fields under one or more of U.S. Patents 5,656,493, 

5,333,675, 5,475,610 (claims 1, 44, 158, 160–163 and 167 only), and 6,703,236 (claims 1–7 only), or corresponding claims in 

their non-U.S. counterparts, owned by Applera Corporation. No right is conveyed expressly, by implication or by estoppel under 

any other patent claim, such as claims to apparatus, reagents, kits, or methods such as 5’ nuclease methods. Further information 

on purchasing licenses may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, 

Foster City, California 94404, USA. 

These products are covered by one or more of the following U.S. patents or their foreign counterparts owned by Eppendorf AG: 

U.S. Patent Nos. 6,767,512 and 7,074,367. 

Effective February 1, 2009
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Explanation of Symbols

CAUTION: Risk of Danger! Wherever this symbol appears, always consult note in this manual 
for further information before proceeding. This symbol identifies components that pose a risk of 
personal injury or damage to the instrument if improperly handled.

CAUTION: Risk of Electrical Shock! This symbol identifies components that pose a risk of 
electrical shock if improperly handled.

CAUTION: Hot Surface! This symbol identifies components that pose a risk of personal injury 
due to excessive heat if improperly handled.

Safety Warnings and Guidelines
Warning: Operating the MJ Mini™ Peltier thermal cycler before reading this manual can con-
stitute a personal injury hazard. Only qualified laboratory personnel trained in the safe use of 
electrical equipment should operate this machine.

Warning: Do not open or attempt to repair the MJ Mini cycler base, the power supply, the 
heat pump/sample block, or other accessory. Doing so will void your warranties and can put 
you at risk for electrical shock. Return the MJ Mini cycler to the factory (US customers) or an 
authorized distributor (all other customers) if repairs are needed. 

Warning: The sample blocks can become hot enough during the course of normal operation 
to cause burns or cause liquids to boil explosively. Wear safety goggles or other eye protection 
at all times during operation.

Warning: The  MJ Mini cycler incorporate neutral fusing, which means that live power may still 
be available inside the machines even when a fuse has blown or been removed. Never open 
the cycler base; you could receive a serious electrical shock. Opening the base will also void 
your warranties.

 Safe Use Guidelines
The MJ Mini thermal cycler is designed to be safe to operate under the following conditions:

n	I ndoor use

n	A ltitude up to 2,000 m

n	 Temperature 5˚C to 40˚C

n	 Maximum relative humidity 80% for temperatures up to 31˚C, decreasing linearly to 50% relative  
humidity at 40˚C

n	 Mains supply voltage fluctuations not to exceed ±10% of the nominal voltage

n	I nstallation categories (overvoltage categories) II

n	 Pollution degree 2

n	E lectrical Supply, 100-240 VAC, 50-60 Hz, 400 W
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Electromagnetic Interference
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

This device has been tested and found to comply with the EMC standards for emissions and 
susceptibility established by the European Union at time of manufacture.

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications.

LE PRESENT APPAREIL NUMERIQUE N’EMET PAS DE BRUITS RADIOELECTRIQUES DEPASSANT 
LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A PRESCRITES DANS 
LE REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR LE MINISTERE DES 
COMMUNICATIONS DU CANADA.

FCC Warning
Warning:  Changes or modifications to this unit not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Note:  This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radiofrequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.

Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits.

Regarding FCC Compliance:  Although this design of instrument has been tested and found to comply 
with Part 15, Subpart B of the FCC Rules for a Class A digital device, please note that this compliance is 
voluntary, for the instrument qualifies as an “Exempted device” under 47 CFR § 15.103(c), in regard to the 
cited FCC regulations in effect at the time of manufacture.

Warranty
The MJ Mini thermal cycler and associated accessories are covered by a standard Bio-Rad warranty. 
Contact your local Bio-Rad Laboratories office for the details of the warranty.
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Documentation Conventions
Typographic Conventions

	 Example  	 Meaning

	<<PROCEED>> 	 The names of keyboard keys are encased in double angle brackets.

	 Italics 	S elect Edit from the Main Menu.

This instrument system is labeled, For Research Use Only.

Graphic Conventions
The programming screens displayed in the LCD window can display up to seven lines of text  
at one time. 

Example

New:          Lid:100˚C    
ABCD          Vol: 20µL
1= 92.0˚ FOR 0:30  
2=

LOWER TEMP ˚C:

Terminology
A programming option is termed “selected” when the option is highlighted. In this manual, the selected 
terms are outlined (see the example above).
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MJ Mini Thermal Cyclers
The MJ Mini™ thermal cycler features:

■	 Premium cycling in a medium capacity cycler: the MJ Mini thermal cycler can hold 48 x 0.2 ml tubes, 
12 x 0.5 ml tubes or one 48-well microplate

■	A bility to program and maintain a 16˚C temperature gradient, front-to-back, along the block for  
protocol optimization in a single run

■	I ntegrated Hot Bonnet® heated lid for oil-free thermal cycling. The heated lid pressure may be  
manually adjusted to permit the seating of different vessels

■	I ntuitive software with an easy-to-read interface for rapid input of programs, which may contain  
advanced protocol steps such as auto-time extension, auto-temperature increment, and variable 
ramp rates.

■	 Choice of calculated sample temperature control for highest speed and accuracy or block control  
for compatibility with protocols designed for a variety of instrument types.

■	S pace-saving design for easy setup and transportation.

■	I nstant Incubate feature for continuous-temperature incubations.

■	 Customizable factory-installed protocols.

Important Safety Information
Safe operation of the MJ Mini thermal cycler begins with a complete understanding of how the machine 
works. Please read this entire manual before attempting to operate the system. Do not allow anyone 
who has not read this manual to operate this machine. 

Warning: The MJ Mini cycler can generate enough heat to inflict serious burns and can deliver 
strong electrical shocks if not used according to the instructions in this manual. Please read the 
safety warnings and guidelines at the front of this manual, and exercise all precautions outlined 
in them. 

Warning: Do not block the MJ Mini cycler’s air vents (see Figure 4 for locations). Obstructing 
air vents can lead to overheating and increases the risk of electrical shock and fire.
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Layout of the MJ Mini thermal cycler

Figure 1. Front view of the MJ Mini thermal cycler.

Figure 2. Control panel of the MJ Mini thermal cycler.
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Figure 3. Back view of the MJ Mini thermal cycler.

Figure 4. Bottom view of the MJ Mini thermal cycler.
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Specifications

MJ Mini Thermal Cycler

Thermal range:		 0–99.9˚C, but no more than 30˚C below ambient temperature

Thermal accuracy:		 ±0.2˚C of programmed target @ 90˚C, NIST-traceable

Thermal uniformity:		 ±0.4˚C well-to-well within 10 sec of arrival at 90˚C 

Ramping speed:		A verage ramp rates are 1.5˚C/sec, with a maximum rate of 2.5˚C/sec

Sample capacity:		 48 x 0.2 ml tubes, 12 x 0.5 ml tubes, or one 48-wel	microplate

Line voltage:		 100–240 VAC rms (no adjustment needed among  
		 voltages within these ranges)

Frequency:		 50–60 Hz single phase

Power:		 400 W maximum

Fuses:		 Two 6.3 A, 250 V, 5 x 20 mm

Displays:		 64 x 128 backlit LCD

Ports:		 Two USB ports for access by service personel from Bio-Rad Laboratories

Memory:	 400 typical programs in 12 folders

Weight:		 4.1 kg

Size (W x D x H):			   18 x 32 x 20 cm

Specifications

Gradient

Temp gradient accuracy:	 ±0.2°C of programmed target at end rows, 10 sec after the timer starts for the gradient step, 		
	 NIST–traceable

Thermal row uniformity:	 ±0.4°C , in row, well-to-well, within 10 sec of reaching target temperature

Calculator accuracy:		 ±0.4°C of actual row temperature, NIST-traceable

Gradient range:		  35–99°C

Thermal Gradient differential  
range: 					     1–16°C
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Packing Checklist
After unpacking the MJ Mini thermal cycler, check to see that you have received the following:

n	O ne MJ Mini thermal cycler
n	 Two spare fuses
n	O ne power cord
n	 MJ Mini Gradient Thermal Cycler Instruction Manual (this document)

If any of these components is missing or damaged, contact Bio-Rad Laboratories to obtain a 
replacement. Please save the original packing materials in case you need to return the instrument  
for service. 

Setting Up the MJ Mini Instrument
The MJ Mini cycler requires minimal assembly: plugging in the power cord. Insert the power cord 
plug into its jack at the back of the machine (see fig. 3 for location of jack), then plug the cord into an 
electrical outlet. 

Environmental Requirements
Ensure that the area where the thermal cycler is installed meets the following conditions, for reasons of 
safety and performance:

n   	Nonexplosive environment

n   	Normal air pressure (altitude below 2000 m)

n   	Ambient temperature 5˚–31˚C

n   	Relative humidity up to 80% 

n   	Unobstructed access to air that is 31˚C or cooler (see below)

n   	Protection from excessive heat and accidental spills. (Do not place the MJ Mini thermal cycler 
near heat sources, such as radiators, and protect it from the danger of having water or other fluids 
splashed on it, which can cause shorting in its electrical circuits.)

Power Supply Requirements
The MJ Mini thermal cycler requires 100–240 V, 50–60 Hz, and a grounded outlet. This cycler can use 
current in the specified range without adjustment, so there is no voltage-setting switch.

Power cords for outlets other than the US 120 V outlet may be purchased from computer stores, since 
they are also used for most desktop computers and printers and meet international standard IEC-
320. The power cord must be rated to carry at least 10 A at 125 V or 250 V, depending on the voltage 
available in your nation. The quality of the power cord can be further ensured by making certain it is 
inscribed with the trademark of UL, CSA, TUV, VDE, or another national testing agency. 

Note: Do not cut the supplied 120 V power cord and attach a different connector. Use a one-piece 
molded connector of the type specified above.
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Air Supply Requirements
The MJ Mini thermal cycler requires a constant supply of air. Air is taken in from vents at the front of 
the instrument is exhausted from vents at the back (see fig. 4). If the air supply is inadequate or too hot, 
the machine can overheat, causing performance problems, software error messages (particularly “HS 
Overheating” and “Slow Block Cycling”), and even automatic shutdowns. 

Ensuring an Adequate Air Supply

n   	Do not block the air intake vents.

	 Position the MJ Mini thermal cycler at least 10 cm from vertical surfaces and other thermal cyclers 
(greater distances may be required; see below). Do not put loose papers under or in front of the  
machine; they can be sucked into the air vents and cause problems. 

n   	Do not allow dust or debris to collect in the air intake vents. 

	 The air vents are particularly liable to collect dust and debris, sometimes completely clogging up. 
Check for dust and debris every few months, and clean the intake vents as needed. Remove light 
collections of dust with a soft-bristle brush or damp cloth. Severe collections of dust and debris 
should be vacuumed out. Turn the machine off prior to cleaning or vacuuming air vents. 

Ensuring That Air Is Cool Enough

n   	Do not position two or more thermal cyclers so that the hot exhaust air of one blows directly into the 
air intake vents of another.

n   	Make sure the MJ Mini thermal cycler receives air that is 31˚C or cooler by measuring the temperature 
of air entering the machine through its air intake vents. Air intake vents are located at the front of the 
machine (see fig. 4).

Place the thermal cycler where you plan to use it, and turn it on. Try to reproduce what will be typical 
operating conditions for the machine in that location, particularly any heat-producing factors (e.g., 
nearby equipment running, window blinds open, lights on). Run a typical protocol (e.g., BASIC) for 30 
minutes to warm up the cycler, then measure the air temperature at the air intake vents. If more than 
one machine is involved, measure the air temperature for each.

If the air intake temperature of any machine is warmer than 31˚C, use table 1 to troubleshoot the 
problem. Some experimentation may be required to determine the best solution when more than one 
cause is involved. After taking steps to solve the problem, verify that the temperature of the air entering 
the air intake vents has been lowered, using the procedure outlined above.

Table 1. Troubleshooting air supply problems

Cause	 Possible Remedies

Air circulation is poor.	� Provide more space around machine or adjust room ventilation.

Ambient air temperature is high.	A djust air conditioning to lower ambient air temperature.

Machine is in warm part of room.	� Move machine away from, or protect machine from, such heat sources as radiators, 
heaters, other equipment, or bright sunlight.

Machines are crowded.	�A rrange machines so that warm exhaust air does not enter intake vents.

	I nstallation
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Turning the MJ Mini Cycler On
Move the power switch to “o” (the “On” position). The fan will turn on, and the Cooling/Heating lights on 
the keyboard will flash. The MJ Mini cycler will enter a self-test of the heat pumps. 

Note:   If the sample block or the heat sink is not at ambient temperature (typically because the sample 
block was recently in use), the machine will skip the self-test.

If the self-test does not detect any problems, the Main Menu is displayed. Alternatively, depressing the 
«Screen» button will bring you to the main screen.

 
RUN	 VIEW
NEW	 FILES
EDIT	 TOOLS

Block is idle

The MJ Mini cycler is now ready to execute programs.

Understanding the Main Menu
The Main Menu is the common access point to all programming and machine configuration screens:

n    RUN: Executes a program.
n    NEW: Allows new programs to be entered.
n    EDIT: Allows modification of stored programs.
n    VIEW: Accesses utilities that display a program’s steps.
n    FILES: Accesses file management utilities.
n    TOOLS: Accesses machine configuration screens.

Using the Control Panel
The control panel (see fig. 2) includes operation keys, status indicator lights for heating and cooling, an 
LCD window for displaying programming and machine status text, and a numeric keypad for entering 
values into programs. 

Operation Keys 

n	 Select keys (left, right, up, down arrows): Move the cursor one space or option in the LCD window.

n	 Proceed/Enter: Accepts a selected menu or screen option; during a protocol run, advances the 	
program to its next step.

n	 Cancel: Terminates a running protocol; during program creation or editing, cancels the last entry.

n	 Pause: Pauses a protocol during execution.

n	 Instant: Initiates a program that sets up the MJ Mini as a simple incubator.
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n   	Screen: Switches between protocol status screens, the Main Menu and a time remaining display in 
the LCD window during a protocol run. In addition, this button toggles between the Main Menu and 
the “About” screen for the instrument, and allows the users to alternately view the text and graphical 
programming screens.

Status Indicator Lights

n   	Block Status lights: Indicate whether the sample block is heating (red light is illuminated) or cooling 
(blue light is illuminated). 

Opening and Closing a Sample Block 
Grip the front handle of the Hot Bonnet heated lid and pull upward firmly. The top lever will pop open to 
reveal the entire thumbwheel. Continue pulling upward to open the Hot Bonnet lid. The Hot Bonnet lid 
will tip backward, revealing the entire block. 

Caution: Do not pull on the thumbwheel to open the unit. This can damage the closing mechanism of 
the Hot Bonnet lid.

To close the sample block, press down on the top lever. The lever will close down over the thumbwheel 
as the Hot Bonnet lid closes down over the sample block. A click signifies that the lid’s latch has 
engaged. 

Selecting the Correct Sample Vessel
The MJ Mini cycler accepts both 0.2 ml and 0.5 ml tubes as well as 48-well microplates. Keep in mind 
that differences in tube and plate composition and wall thickness among the many brands available can 
affect reaction performance. Protocols may require some adjustment to ensure optimum performance 
when using a new vessel type. Bio-Rad offers a full range of tubes and microplates manufactured to the 
specifications of the sample block of MJ Mini cycler. See Table 2 for a complete list. 

0.5 ml Tubes

It is possible to load up to twelve 0.5 ml tubes in the MJ Mini cycler.  Since 
the width of the 0.5 ml tubes does not allow them to be accommodated 
in adjacent wells, the tubes should be placed in a staggered fashion (i.e., 
in every other well in the block). The tubes should NOT be placed in the 
spaces between wells.  Furthermore, placement of tubes in the peripheral 
wells along the edge of the cycler block should be avoided, as this may 
result in compromised amplification due to condensate formation. For 
correct placement of 0.5 ml tubes, see Figure 5.

When using 0.5 ml tubes, thin-walled tubes are recommended; these are 
specifically designed for thermal cycling and the higher-quality brands 
provide a good and consistent fit. If thick-walled 0.5 ml tubes are used, 
ensure that they fit the wells snugly. (Since these tubes were originally 
designed for centrifuges, some brands may not fit tightly in thermal cycler 
wells.) Both thin and thick-walled 0.5 ml tubes are available from Bio-Rad 
and are designed for precise block fit.

Figure 5. Wells (3) in which 0.5 
ml tubes should be placed 

	O peration
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Thin-Walled Vs. Thick-Walled Tubes
The thickness of sample tubes directly affects the speed of sample heating and thus the amount of 
time required for incubations. Thick-walled tubes delay sample heating, since heat transfers more 
slowly through the tubes’ walls. For the earliest types of thermal cyclers this delay mattered little. These 
machines’ ramping rates were so slow (below 1°C/sec) that there was plenty of time for heat to transfer 
through the tube wall to the sample, during a given incubation.

Modern thermal cyclers have much faster ramping rates, so the faster heat transfer provided by thin-
walled tubes allows protocols to be significantly shortened. Essentially, up to 30 seconds can be saved 
per cycle by using thin-walled tubes, for an overall savings of 15 minutes in a 30-cycle run.

0.2 ml Tubes

All types of thin-walled 0.2 ml tubes may be used. Bio-Rad sells high-quality 0.2 ml tubes in a number 
of styles, including individual tubes and strips.

Microplates

A variety of polypropylene 48-well microplates can be used in the MJ Mini cycler as long as they fit the 
wells snugly. In addition, the Multiplate™ line of 96-well plates and Microseal® film seals can be cut down 
to fit in the sample block of this instrument. Polypropylene microplates and compatible Microseal film or 
strip caps for sealing are available from Bio-Rad Laboratories.

Sealing Sample Vessels 
To avoid changing the concentration of reactants, steps must be taken to prevent the evaporation of 
water from reaction mixtures during thermal cycling. Only a layer of oil or wax will completely prevent 
evaporation from the surface of the reaction fluid. However, an adequate degree of protection can be 
achieved by sealing vessels with caps, film, or adhesive seals then cycling the samples using the heated 
lid to prevent condensation.

Sealing with Oil or Wax

Mineral oil, silicone oil, paraffin wax, or Chill-out™ liquid wax may be used to seal samples. Use only a 
small amount of oil or wax; 1-3 drops (15–50 µl) are usually sufficient. (Include this volume in the total 
volume when setting up a calculated-control protocol; see “Choosing a Temperature Control Mode” in 
chapter 5.) Use the same amount of oil or wax in all sample vessels to ensure a uniform thermal profile.

Most paraffin waxes solidify at room temperature. The wax can then be pierced with a micropipette 
tip and the samples drawn off from below the wax. Silicone oil and mineral oil can be poured off or 
aspirated from tubes if the samples are first frozen (–15° to –20°C). The samples are usually pure 
enough for analysis without an extraction. 

Chill-out liquid wax (available from Bio-Rad Laboratories) is an easy-to-use alternative to oil. This purified 
paraffinic oil solidifies at 10°C and is liquid at room temperature. By programming a holdstep at low 
temperature, the wax can be solidified at the end of a run. A pipette tip can then be used to pierce the 
wax in the tubes and remove the samples. The wax is available in a clear, optical-assay grade or dyed 
red to assist in monitoring its use. The red dye has no adverse effects on fluorescent gel analysis of 
reaction products.



21In the U.S., call toll free at 1-800-4BIORAD (1-800-424-6723)  |  Visit on the Web at www.bio-rad.com

Sealing with the Hot Bonnet Lid

The Hot Bonnet heated inner lid maintains the air in the upper part of sample vessels at a higher 
temperature than the reaction mixture. This prevents condensation of evaporated water vapor onto the 
vessel walls and lid, so that solution concentrations are unchanged by thermal cycling. The Hot Bonnet 
lid also exerts pressure on the tops of vessels loaded into the block, helping to maintain a vapor-tight 
seal and to firmly seat tubes or the plate in the block. 

Caps, film, adhesive seals, or mats must be used along with the Hot Bonnet lid to prevent evaporative 
losses. 

Note:  When tubes are cooled to below-ambient temperatures, a ring of condensation may form in 
tubes above the liquid level but below the top of the sample block. This is not a cause for concern since 
it occurs only at the final cool-down step, when thermal cycling is complete.

Microseal ‘A’ film offers a quick alternative to sealing microplates or arrays of tube strips. This film is 
specially designed to seal tightly during cycling, yet release smoothly to minimize the risk of aerosol 
formation and cross-contamination of samples. Microseal ‘A’ film, designed to cover a 96-well plate, is 
easily cut for use with fewer than 96 samples. 

Microseal ‘B’ adhesive seals feature an aggressive adhesive, effective from –20°C to 110°C, which 
allows secure sample storage or transport before and after cycling. The clear polyester backing allows 
easy inspection of sample wells. Microseal ‘B’ clear, adhesive seals are ideal for thermal cycling in all 
polypropylene and polystyrene microplates. Microseal ‘B’ adhesive seals can be easily cut for use with 
fewer than 96 samples. 

Microseal ‘F’ aluminized foil acts as a barrier against evaporation from –20˚C to 105˚C. In addition to 
cold storage applications, it can also be used for thermal cycling sample volumes ≥25 µl. The foil is thin 
enough to pierce with a pipet tip for recovery of sample from individual wells. Microseal ‘F’ foil is easily 
cut for use with fewer than 96 samples. 

Adjusting the Hot Bonnet Lid’s Pressure
The pressure exerted by the Hot Bonnet lid must be manually adjusted to fit the sample vessels being 
used. Once set, the Hot Bonnet lid can be opened and closed repeatedly without readjustment as long 
as neither the tube or microplate type nor the sealing method is changed. Any change in vessel type or 
sealing method requires readjustment of the Hot Bonnet lid.

Follow these steps to adjust the pressure exerted by the inner lid:

1.	 Make sure the block’s wells are clean. Even tiny amounts of extraneous material can decrease ther-
mal conductance and interfere with the proper seating of a microplate or tubes.

2.	O pen the Hot Bonnet lid. Turn the thumbwheel all the way counterclockwise to completely raise the 
inner lid.

3.	 Load either a microplate or at least eight individual tubes into the sample block. The inner lid pivots 
around a central point, so it is important to distribute individual tubes evenly: load at least four tubes 
in the center of the block and at least one tube in each of the four corners of the block. If using a 
sealing film or mat, apply it to the loaded microplate according to the manufacturer’s directions. 

4.	 Close the Hot Bonnet lid by pressing down on the top lever. Turn the thumbwheel clockwise to lower 
the inner lid onto the loaded microplate/tubes. The thumbwheel turns easily at first since the inner lid 
has not yet come into contact with anything. Stop turning the thumbwheel when you feel increased 
resistance, which indicates that the inner lid has touched the microplate/tubes.

		O  peration
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5.	 For microplate sealing films or mats that require additional pressure, turn the thumbwheel clockwise 
an extra half turn past the point of initial contact to set an appropriate lid pressure. 

Caution:  Do not turn the thumbwheel more than three-quarters of a turn. This can make it hard or 
impossible to close the lid and puts excessive strain on the latch holding the lid closed. 

An extra half to three-quarters of a turn ensures the correct pressure for most types of reaction vessels. 
Some empirical testing may be required to determine the optimum pressure required for certain vessels. 
Once this pressure has been determined, the thumbwheel position may be marked with a colored 
marking pen or piece of tape.

Note:  As an aid in gauging how much the thumbwheel has been turned, mark it at the quarter turn 
positions, or every sixth “bump” on the thumbwheel (there are 24 total “bumps”).

Loading Sample Vessels into the Block
When using a small number of tubes, load at least one empty tube in each corner of the block to ensure 
that the Hot Bonnet lid exerts even pressure on the sample tubes (see “Adjusting the Hot Bonnet Lid’s 
Pressure,” above).

To ensure uniform heating and cooling of samples, sample vessels must be in complete contact with 
the block. Adequate contact is ensured by always doing the following: 

n	E nsure that the block is clean before loading samples (see chapter 9 for cleaning instructions).
n	 Firmly press individual tubes or the microplate into the block wells.

Using Oil to Thermally Couple Sample Vessels to the Block

With two exceptions (see below), Bio-Rad does not recommend using oil to thermally couple sample 
vessels to the block, for the following reasons: 

n	 Calculated-control protocols do not run accurately when oil is used. 
n	O il traps dirt, which interferes with thermal contact between vessels and the block.
n	 Calculated-control protocols do not run accurately when oil is used. 
n	O il traps dirt, which interferes with thermal contact between vessels and the block.

Caution: If you use oil in the block, use only mineral oil. Never use silicone oil. It can damage the 
sample block.

One exception to this recommendation involves the use of volatile radioactive 35S nucleotides. A small 
amount of oil in the block can help prevent escape of these compounds. See page 24 for important 
information regarding safe use of these compounds in polypropylene tubes and polypropylene and 
polycarbonate microplates. A second exception involves the use of thick-wall 0.5 ml tubes. Certain 
brands of these tubes fit poorly in the block, in which case, oil may somewhat improve thermal contact. 
Whenever possible, use high-quality thin-wall tubes intended for thermal cycling (see page 23 for a tube 
and plate selection chart).
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Tube, Microplate, and Sealing System Selection Chart
The following sample vessels and sealing options are recommended for use with the MJ Mini thermal 
cycler. These items are available from Bio-Rad Laboratories.

Key	

            4  Reaction vessel fits block/sealing option fits reaction vessel without modification. 

            #  Reaction vessel/sealing option can be cut to fit.

Table 2. Compatible sample vessels and sealing options.

	 Thermal  
	 Cycler	 Reaction Vessels	 Sealing Options for Oil-free Cycling

 				    Microseal	 Microseal	 Microseal		  Chill-out 
	 		  Bio-Rad	 ‘A’ Film	 ‘B’ Seal	 ‘F’ foil	 Strip caps	 wax 
	 MJ Mini	 Description	 Catalog #	 MSA-5001	 MSB-1001	 MSF-1001	 TCS-series 	 CHO-series

	 ✂	�	 Multiplate™ unskirted	 MLP-series	 ✂	 ✂	 ✂	✓	✓    
96-well microplates	 MLL-series

	✓	�	  Multiplate unskirted	 MLP-series	 ✂	 ✂	 ✂	✓	✓   
	48-well microplates

	✓		�  Multiplate unskirted	 MLP-2401	 ✂	 ✂	 ✂	✓	✓   
24-well microplates

	 ✂		� 0.2 ml strip tubes	 TBS-series	 ✓			✓	✓     
8/strip & 12/strip	 TLS-series

	✓	�	  0.2 ml individual tubes	 TFI-0201	 ✓			✓	✓     
		TBI-series

	✓	�	  0.5 ml individual	 TBI-series	 				✓     
tubes, w/ caps

✓ 	 Reaction vessel fits block/sealing option fits reaction vessel without modification.  
✂ 	 Reaction vessel/sealing option can be cut to fit.

		O  peration
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Safety Warning Regarding Use Of 35S Nucleotides
Some researchers have experienced a problem with radioactive contamination when using 35S in 
thermal cyclers. This problem has occurred with all types of reaction vessels.

The Problem

When 35S nucleotides are thermally cycled, a volatile chemical breakdown product forms, probably SO2. 
This product can escape the vessel and contaminate the sample block of a thermal cycler, and possibly, 
the air in the laboratory. Contamination has been reported with microplates, 0.2 ml tubes, and 0.5 ml 
tubes.

Polycarbonate Reaction Vessels
The largest risk of contamination occurs when using 96-well polycabonate microplates. Polycarbonate 
is somewhat permeable both to water and the 35S breakdown product. This problem is exacerbated 
when polycarbonate plates are held at high temperatures for long periods of time, or when the plates 
are sealed for oil-free thermal cycling.

Polypropylene Reaction Vessels
Polypropylene tubes and microplates are manufactured with very thin walls to enhance thermal transfer. 
The thin walls are somewhat fragile and can “craze” or develop small cracks when subject to  
mechanical stress. Undamaged thin polypropylene tubes may also be somewhat permeable to  
the 35S breakdown product. Either way, there have been reports of 35S passing through the walls  
of 0.2 ml polypropylene tubes of several different brands during thermal cycling. Contamination  
problems are rarer with 0.5 ml polypropylene tubes, but instances have been reported. No data  
are yet available on radioactive contamination with polypropylene microplates.

The Solution

1.	S ubstitute the low-energy beta emitter 33P in cycle sequencing. 33P nucleotides are not subject to 
the same kind of chemical breakdown as 35S nucleotides, and they have not been associated with 
volatile breakdown products.

2.	I f 35S must be used, three things will help control contamination: an oil overlay inside the tubes, min-
eral oil in the thermal cycler outside the tubes, and use of thick-walled 0.5 ml tubes. Always run 35S 
thermal cycling reactions in a fume hood, and be aware that vessels may be contaminated on  
the outside after thermal cycling. Please be certain that you are using the appropriate detection  
methods and cleaning procedures for this isotope. Consult your radiation safety officer for his or  
her recommendations.

	I f mild cleaning agents do not remove radioactivity, harsher cleaners may be used occasionally and 
carefully. Users have suggested the detergent PCC-54 (Pierce Chemical Co., Rockford, Illinois; Pierce 
Eurochemie B.V., Holland), Micro Cleaning Solution (Cole-Parmer, Niles, Illinois), and Dow Bathroom 
Cleaner (available in supermarkets).

Caution: Harsh cleaning agents (such as those above) are corrosive and must be  
thoroughly rinsed away within a few minutes of application. They can eat away the  
surface finish of the blocks.
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Running a Protocol
Running a protocol on the MJ Mini thermal cycler involves two steps: 

1.  Choosing a stored protocol to run

2.  Setting up the temperature control method

Either a custom-designed protocol or one of the factory-installed resident protocols may be run. See 
appendix A for descriptions of the resident protocols, which may be edited to fit your needs (see chapter 
7 for instructions on editing stored programs). All the factory-installed protocols are stored in a single 
folder, called the <MAIN> folder, at the time of shipping.

Choosing a Stored Protocol to Run

With the Main Menu displayed, select Run, then press «Proceed». One of two types of screen will be 
displayed, depending on whether custom protocols have been stored in the <MAIN> folder or in custom 
folders:  

n   If all protocols have been stored in the <MAIN> folder: 

A screen listing the protocols will be displayed. Custom protocols are listed first, followed by the factory-
installed programs:

Use the Select keys to scroll through the listed protocols. Scroll past the last- or first-listed protocol to 
see the next screen down or up. Select the desired protocol, then press «Proceed».

n   If custom protocols have been stored in one or more custom folders: 

A list of folders will appear on the left of the screen and a list of programs residing in these folders will 
appear on the right. In the example below, since the MAIN folder is highlighted, the list of programs that 
reside in the MAIN folder appears on the right.

Select the folder that contains the protocol you wish to run, then press the right «Select» key to toggle 
over to the list of protocols located in that folder. Use the Select keys to scroll through the listed 
protocols and select the desired protocol, then press «Proceed». 

Run:	       PROGRAMS
<MAIN>	 iPRF1kb 
		  iPRF8kb 
		  iPRF15kb 
		  LONG-2 
		  LONG-3

Run:	    	    PROGRAMS
	    iPRF1kb 

<FOLDER1>  iPRF8kb <FOLDER2> 
iPRF15kb 
                    LONG-2 
		     LONG-3
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In either instance, after you press «Proceed», a screen similar to the one below will be displayed:

 
The top line of the screen will identify the selected protocol (iPRF1kb in the example). The other lines 
on the screen will request information needed to set up the temperature control method (explained 
below). Enter the reaction volume and press «Proceed». The cursor moves over to the «Run» option. 
However, before you run the protocol, you may select to VIEW the protocol steps, by selecting «View» 
and pressing «Proceed».

 
The steps are listed along with the default heated lid temperature and selected reaction volume. In this 
case, you need to use the «Select» keys to scroll downward to view all protocol steps. 

By selecting «Proceed» again, you are brought back to the previous screen, from which you can 
highlight and select «Run» to commence the cycling program.

Tip: The MJ Mini thermal cycler comes pre-loaded with a series of template protocols for a variety of 
common applications (See Appendix A for a full list of protocols). You may chose to run these programs 
as they are, or to adjust  certain parameters in order to optimize your reactions. 

Selecting Calculated Temperature Control Mode vs. Block Control Mode

With the MJ Mini thermal cycler, the default setting for running a protocol is calculated temperature 
control method. This temperature control method compensates for the fact that the sample’s 
temperature lags behind the block temperature. When creating a new protocol, you will be asked to 
enter a sample volume. The cycler will automatically take this volume into account when running the 
protocol and by employing small temperature overshoots, the cycler rapidly brings the sample to its 
target temperature. Every time you select a protocol to run, you will be asked to enter a sample volume. 

By entering zero in the Sample Vol field, the cycler will enter Block Control Mode, this mode does not 
employ the small temperature overshoots. As a result, it will take slightly longer for the sample to reach 
its target temperature and the protocol will generally take a little longer to run. 

Run: 
 iPRF1kb?

Sample Vol: 20µl
RUN  VIEW

View:                   Lid:100˚C
 iPRF1kb              Vol: 20µl

1= 95.0 ,̊  2:00 
2= 92.0 ,̊  0:01 
3= 70.0 ,̊  0:10

	 Running Protocols
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Reading the Runtime Screen
When a protocol is running, a runtime screen will be displayed:

The screen lists: the protocol name (iPRF1kb in the example above), protocol step that is running (Step 
1), and either the block temperature for block-control protocols or the calculated sample temperature for 
calculated-control protocols. When the step’s target temperature is reached, a timer starts in the “Temp” 
line (min:sec).

By pressing the Left arrow button, you can view the lid temperature. This screen shows only as long as 
the left «Select» key is pressed. The runtime screen returns when you stop pressing the key.

By pressing the Right arrow button, you can view the total time that the protocol has been running, 
the total time remaining in the protocol, and the cycler number that the protocol is currently running. 
This screen is displayed only as long as the key is pressed. The runtime screen returns when you stop 
pressing the key.

Reading the Temperature Display Screen
By pressing the «Screen» button, you can toggle between different screens during a protocol. Pressing 
the button once will bring you to the temperature display screen:

This screen lists a shorthand version of the protocol. On the left, the list of the temperature steps 
appears. In this case, the denaturation temperature (90.0) is followed by the annealing temperature 
(64.0) as well as an extension time of 72.0. This temperature pattern is repeated 29 times (as indicated 
by the GOTO step in the protocol, as well as the 29x shown at the bottom of the screen). This cycling 
is followed by a final hold step of 10.0. On the right, a diagrammatic representation of the protocol is 
presented. In the example above, the cycler is currently holding the samples at 64.0˚C. On the left, this 
step is highlighted, and on the diagrammatic representation this step is blinking. A counter on the top 
line of this screen marks the amount of time that has passed on this step (min:sec).

            Running:
            iPRF1kb     

Step 1:	  95.0˚ 2:00 
Step 2:	  92.0˚ 0:01 
Step 3:	  70.0˚ 0:10

90.0  0:09

         
72.0 
GOTO  
10.0
                 29x
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Time Remaining Screen

Press the «Screen» button once more, to see the time remaining in the protocol:

The time is noted in hours:min:sec. In this case, there are 25 minutes and 55 seconds remaining until 
the program is complete. This screen is particularly useful in lab settings where multiple cyclers are 
being run. 

From the Time Remaining Screen, pressing the «Screen» button returns the user to the Main Menu. This 
is the same screen that we have encountered previously, except that the bottom line indicates that the 
thermal cycler is engaged in running a protocol.

Reading the Protocol Completion Screen 
When the protocol finishes, a long beep sounds and the Main Menu appears. From this Main Menu, you 
may select the «Screen» button to review the parameters of the protocol that just finished running.

Certain error messages may also be displayed in this screen (see chapter 10). Press «Proceed» to return 
to the Main Menu.

00:25:55
        Time Remaining

 
   LAST RUN:  iPRF1kb 
       HOTLID:  99,30 
     VOLUME:  20 
    ELAPSED:  8:47 
     ERRORS:  None 
SOFTWARE:  v.1.1A

RUN	VIEW 
NEW	FILES 
EDIT	TOOLS

Running: iPRF1kb

		  Running Protocols
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Manually Stepping Through a Protocol
During a protocol run, pressing «Proceed» allows you to advance the protocol to the next programmed 
step, even if the machine is currently ramping the block’s temperature (see chapter 6 for information on 
ramping). A confirmation screen will be displayed:

Select Yes, then press «Proceed». The protocol will advance to its next step.

Pausing a Running Protocol
Press «Pause» to temporarily stop a running program. The clock will be replaced with the word “Pause” 
on the runtime protocol screen:

The samples are held at the displayed temperature until either the «Pause» or the «Proceed» key is 
pressed, which causes the protocol run to resume.

A protocol cannot be paused before the target temperature for a given step has been reached. If 
«Pause» is pressed before this point, the block continues heating or cooling until the target is reached, 
and then the protocol is paused.

             Running: 
             iPRF1kb     
Step 1:  90.0˚ 0:25 
Temp:   90.0˚ 0:10 
Cycle    2 of 39
Goto next step?  Yes  

             Running: 
             iPRF1kb    
Step 1:  90.0˚ 0:25 
Temp:   90.0˚ PAUSE 
Cycle    2 of 39
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Stopping a Running Protocol
Press «Cancel» to stop a running protocol. A cancellation confirmation screen will be displayed:

Select Yes, then press «Proceed» to cancel the protocol. The total run time for the protocol will be 
displayed:

Press «Proceed» to return to the Main Menu.

Note: If the cycler is currently ramping to a temperature, the thermal cycler will continue ramping until it 
reaches its target temperature at which point, you will be able to cancel the program. 

Note: Turning off the machine does not stop a running protocol. The MJ Mini cycler will assume the 
protocol was stopped by a power outage and will resume running the protocol when the machine is 
turned back on (see below). 

  	 Running:
           iPRF1kb     
Step 1: 90.0˚ 0:25 
Temp:   90.0˚ 0:10 
Cycle   2 of 39 
Cancel iPRF1kb  Yes 

PROGRAM CANCELLED

Total Time:     3:21

		  Running Protocols
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Resuming a Protocol After a Power Outage
If a power failure occurs when a protocol is running, the MJ Mini cycler will hold the protocol in memory 
for a minimum of 24 hours to a maximum of 7 days, depending on environmental conditions.

When power is restored, the protocol will begin running from the point at which it was interrupted, and 
a notice about the power interruption will be displayed. The notice will identify the step and the cycle at 
which the power failure occurred, as well as the block’s temperature at the time power was restored:

 
Press «Proceed» to remove this screen. The protocol’s diagrammatic screen will immediately be 
displayed.

Using the Instant Incubation Feature
The MJ Mini cycler may be converted to a constant-temperature incubator by pressing «Instant».  
A screen allowing use of the heated lid will be displayed:

 
Use the «Select» keys to enable or disable the heated lid, then press «Proceed». A screen allowing entry 
of the incubation temperature will be displayed.  

Use the keypad to enter any incubation temperature from 0˚C to 99.9˚C, then press «Proceed». The 
thermal cycler will incubate the sample at the specified temperature until «Cancel» is pressed.

 
    	 Running:
A/C POWER FAILED 
CYCLE 1    STEP 1 
RECOVERED AT 46.8
PRESS PROCEED 
TO CONTINUE

          
INCUBATE:

       Use heated lid?

            Yes   

      Incubate to ˚
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When the sample block reaches the incubation temperature (and when the heated lid achieves the set 
temperature), a timer begins running on the screen. To stop and start the timer, press «Pause». 

Tip: The Pause feature is useful if you need to temporarily remove samples that must be incubated for 
a precise period of time. Pausing the timer while samples are not in the block allows you to track the 
exact duration of their incubation. 

         Incubating to:   
              75.0˚C     
 
STEP 1:75.0˚ FOREVER 
TEMP:  75.0˚ 
Preheating Lid

		  Running Protocols
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The Elements of a Program
MJ Mini cycler programs consist of a series of steps encoding a protocol. These steps are run using one 
of two possible temperature control methods: calculated control or block control.

Programs may contain four types of steps. Two of the steps are mandatory, and two are optional:

1. 	Temperature step (mandatory): Sets a temperature for the sample block as well as the length of time 
it is held at that temperature. The MJ Mini cycler brings the block to this temperature at its maximum 
rate of heating or cooling, unless modifying instructions are added to the program. With Calculated 
Temperature Control Mode, the cycler will incorporate small temperature overshoots to rapidly bring 
the sample to its target temperature—these overshoots, however, do not alter the target temperature 
or the incubation time for a sample. With Block Control, the heat pump brings the sample holder 
rapidly to the target temperature (without any temperature overshoots); samples, therefore, take a 
little longer to reach their target temperature and incubation steps are generally lengthened to accom-
modate this.

2. 	Gradient step (optional): Allows you to program a temperature gradient from front to back along the 
sample block.  The range of any single gradient can be as great as 16°C. The maximum program-
mable temperature is 99°C; the minimum programmable temperature is 35°C.  

3. 	GoTo step (optional): Causes the program to cycle back to an earlier step for a specified number of 
times (up to 9,999 times). 

4. 	End step (mandatory): Instructs the MJ Mini cycler to shut down its heat pump because the program 
is complete.

Additional instructions, termed “options,” can be added to certain program steps to modify their effects:

1. 	Increment: Modifies a temperature step to allow a progressive increase or decrease of temperature 
(0.1˚–10.0˚C per cycle) each time the step is executed in a cycle. This is useful in “touchdown” pro-
grams, when the annealing temperature of an oligonucleotide is not known.

2. 	Extend: Modifies a temperature step to allow progressive lengthening or shortening of a temperature 
step hold (by 1–60 sec/cycle) each time a step is executed in a cycle. This is useful for accommodat-
ing an enzyme with diminishing activity.

3. 	Beep: Modifies a temperature step to make the machine beep when the target temperature is 
reached.

Designing a New Program

Translating a Protocol into a Program

Until you are completely familiar with programming the MJ Mini cycler, you may find it helpful to 
first translate the protocol into program steps and options on paper. Write down the protocol to be 
programmed, one step per line. Then write the type of program step that goes with the protocol steps, 
at the end of each line.  If a protocol step involves an option as well as a program step, write both 
names down on the same line. Finally, write the End step at the bottom of the list; programs will not run 
without this step. Number the lines 1 through N, where N is the final, End line. 
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Using the GoTo Step to Write Short Programs

The GoTo step allows programs of many repetitious steps to be shortened to just a few lines. When 
the program encounters a GoTo step, it returns to a specified step, repeats that step, and repeats all 
steps that follow, back to the GoTo step. When the program has returned, or cycled, back to the step a 
specified number of times, the program moves on to the step that follows the GoTo step.

For example, consider a basic cycle sequencing protocol consisting of 30 repeats of a denaturation, 
and an annealing/extension step. Rather than listing all 60 steps, use a GoTo step to design a short, 
easy-to-enter program:

Raw program:

1.  92˚ for 30 sec

2.  60˚ for 3 min

3.  92˚ for 30 sec

4.  60˚ for 3 min

5.  92˚ for 30 sec

6.  60˚ for 3 min

7.  92˚ for 30 sec

[continues for total of 60 lines]

Choosing a Temperature Control Method

The MJ Mini cycler can control block temperature in two possible ways, and both have different 
implications for the speed and accuracy of sample heating:

n 	 Calculated control: The thermal cycler adjusts the block’s temperature to maintain samples  
of a specific volume in a specific vessel type at programmed temperatures. This includes optimized  
“overshoots” of the block by a few degrees for a few seconds, which bring the samples to the  
programmed temperatures.

n 	 Block control: The thermal cycler adjusts the block’s temperature to maintain the block at  
programmed temperatures, independent of sample temperature. 

Calculated Control
Calculated Control is the method of choice for most types of programs, yielding the most consistent, 
most reliable, and fastest programs. When using calculated control, the thermal cycler maintains a 
running estimate of sample temperatures based on the block’s thermal profile, the rate of heat transfer 
through the sample tube or slide, and the sample volume or mass. Since this estimate is based on 
known quantities and the laws of thermodynamics, sample temperatures are controlled much more 
accurately than with Block Control. 

Hold times can be shortened significantly when protocols are run under Calculated Control. In addition 
to the simple convenience of spending less time running reactions, shorter protocols also help preserve 
enzyme activity and minimize false priming. Cycling denaturations run under Calculated Control are 
usually optimal at 5 seconds. Annealing/extension steps can also be shortened, but the periods for 
these will be reaction specific. 

Thermal cycler program:

1. 	92˚ for 30 sec 

2. 	60˚ for 3 min

3. 	GoTo step 1, 29 times (i.e., cycle back to step 1 
and repeat steps 1 and 2, 29 times)

4. 	End 

	 Creating Programs
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Calculated Control provides for shorter protocols in three ways: 

1. 	Brief and precise block temperature overshoots are used to bring samples to temperature rapidly.

2. 	Incubation periods are timed according to how long the samples, not the block, reside at the target 
temperature.

3. 	The machine automatically compensates for vessel type and reaction volume. 

Block Control

Block Control provides less accurate control of sample temperatures than Calculated Control provides. 
Under Block Control, the temperature of samples always lags behind the temperature of the block. The 
length of the time lag depends on the vessel type and sample volume but typically is between 10 and 
30 seconds. Block Control is chiefly used to run protocols developed for other thermal cyclers that use 
Block Control. 

Modifying Block-Control Programs for Calculated Control

Block-control programs can be changed to calculated control by subtracting at least 15–20 seconds 
from each temperature step. Some empirical testing may be required to adjust modified programs for 
optimum performance. 

Modifying a Program Designed for a Different Machine

The ramp option can be used to adapt programs designed for thermal cyclers with slower maximum 
heating and cooling rates than the MJ Mini thermal cycler. In addition, a given protocol will occasionally 
work better with a slower rate of temperature change; adjusting the ramp rate can be used to optimize the 
program for such a protocol.

Entering a New Program
Programming the MJ Mini cycler moves through five steps:

1. 	Initiating the program.
2. 	Naming the program.
3. 	Choosing a heated lid temperature and sample volume.
4. 	Entering the program’s steps.
5. 	Entering the End step.

Note: Entering a new program occurs in Textual Mode (not Graphical Mode). Edits to a previous saved 
program can take place in Graphical Mode. See Chapter 7 for more information on editing in Graphical 
Mode.

Each step involves entering values from the keyboard or making selections from a menu. Programs may 
be edited as they are being entered.

Programs are automatically saved when the End step is entered. They are stored in the <MAIN> folder 
unless folders have been created for them.
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Initiating the Program

To initiate a new program, select NEW from the Main Menu, then press «Proceed». A naming screen will 
be displayed:  

Naming the Program

Name the program an eight-character word consisting of any combination of letters and numbers.

Press the up «Select» key to scroll forward and the down «Select» key to scroll backward through the 
alphabet. When the character needed is displayed next to Name, press «Proceed». The character 
will be accepted, and the cursor will move one space to the right. Numbers and periods may also be 
inserted by pressing the corresponding keys on the keypad. After any of these buttons are pressed,  
the cursor automatically moves to the right. 

You may use «Cancel» to move back one space and erase the previous character entered. Likewise, 
you may use the left and right «Select» keys move the cursor across the field to alter any of the 
characters in the name. Simply move the cursor over the character you need to change and reenter  
a character.

When the name is complete, press «Proceed» once to accept the last character and again to accept 
the whole name. If the name is already in use for a program, a screen saying “Name In Use” will be 
displayed. If this happens, press «Proceed», then enter a different name.

Choosing a Temperature Control Mode

Choosing a Heated Lid Temperature 

When the program name has been entered, you will be prompted to enter a heated lid temperature. 
Enter a value for the heated lid and press «Proceed». A default temperature may appear in the field,  
if you wish to use this temperature, press «Proceed». 

Note: See page 52 at the end of this chapter for information on selecting a heated temperature.

Choosing a Thermal Cycling Volume

After selecting a lid temperature, you must specify the thermal cycling reaction volume. Enter a value 
for reaction volume and press «Proceed». By entering a sample volume in this field (acceptable range: 
1–100 µl, whole integers only), the cycler will enter Calculated Temperature Control mode. The cycler 
will take into account the sample volume in utilizing small temperature overshoots to rapidly bring the 
sample to its target temperature. This mode offers more efficient temperature cycling of the reactants 
and can lead to reduced protocol times, since generally 5-10 seconds can be shaved off each 
temperature incubation step.

New:          Lid:100˚C    

A                Vol: 20µl

	 Creating Programs
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To enter Block Temperature Control Mode, simply enter “0” in the Sample Vol field. In Block Control 
mode, temperature ramping will proceed at maximum ramp speed (without the temperature overshoots) 
unless otherwise specified. 

Note: When using 0.5 ml tubes, we recommend a minimum sample volume of 20 µl.

Entering the Program’s Steps

Once these header fields have been filled, you will be able to begin entering your steps.You are 
presented with two options from the Edit Menu:

n  	 TEMP enters a temperature step
n  	 GRAD enters a gradient step

Entering a Temperature Step

To enter a temperature step, select Temp then press «Proceed». The first Temp screen will be displayed:

The third line of this screen shows the number of the step being programmed (1 is used in the example 
above). The last line of the screen allows a target temperature (in degrees Celsius) to be entered for the 
step.

Use the keyboard to enter any number between 0 and 99.9˚C as the target temperature (92.0 is used in 
the example below):

Press «Proceed». The target temperature will move to the third line of the screen, and the bottom line 

New:                   Lid:100˚C    

ABCD                  Vol: 20µL

1=   GRAD

New:               Lid:100˚C    ABCD             
Vol: 20µL
1= 

Temp ˚C:   

New:               Lid:100˚C    
ABCD             Vol: 20µL
 1=  

Temp ˚C:  92.0 
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allows a hold time to be entered for the temperature step. Enter the hold time for the step (30 seconds is 
used in the example below):

Note:  If a hold time of zero (0) is entered, the MJ Mini thermal cycler will hold the block at the target 
temperature indefinitely. 

Press «Proceed». The hold time will move to the third line of the screen, and a confirmation menu will be 
displayed on the last line:

Select one of the displayed choices, then press «Proceed»: 

n  	 Yes  accepts the step and displays the Enter Menu again. Use the Enter Menu to enter the next step 
in the program.

n  	 No allows reentry of the target temperature and hold time for the step.

n  	 Option displays the Options Menu (see “Modifying a Program Step with the Options,” p. 46). 

Tip: Avoid programming many short holds of only a few seconds each. This can overheat the block, 
causing the “Heat Sink Overheated” or “Power Supply Overheated” error messages to be displayed and 
triggering automatic shutdowns if the block exceeds its maximum allowable temperature.  

Entering a Gradient Step

When you reach the step at which a gradient is desired, select GRAD from the Enter Menu and then 
press the «Proceed» key. For the purpose of this example, a gradient step will be entered as Step 2: 

New:               Lid:100˚C    
ABCD              Vol: 20µL
 1= 92.0˚ 

Time:        30

New:               Lid:100˚C    ABCD              
Vol: 20µL
1= 92.0˚ FOR 0:30 

OK?      No   Option

New:                 Lid:100˚C    ABCD               
Vol: 20µL
1= 92.0˚ FOR 0:30  
2= TEMP  GOTO END

	 Creating Programs
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The first screen for programming the gradient will appear:

 

Enter the lower limit temperature (for the purposes of this example, 50°C), then press «Proceed».  
The upper temperature screen will appear:

Enter the upper temperature (for the purposes of this example, 66°), then press «Proceed».   
(Use integers only).

Note: The maximum temperature differential that can be programmed along the sample block is 16˚C. 

The next screen requires you to enter a hold time for the temperature gradient step:

Enter the hold time in the form of min:sec (we have chosen 30 sec for the example below). Press 
«Proceed». A confirmation screen will appear:

New:          Lid:100˚C     
ABCD          Vol: 20µL
1= 92.0˚ FOR 0:30  
2= 

LOWER TEMP ˚C:

New:          Lid:100˚C     
ABCD          Vol: 20µL
1= 92.0˚ FOR 0:30  
2= 50˚

UPPER TEMP ˚C:

New:                 Lid:100˚C     
ABCD                Vol: 20µL
1= 92.0˚ FOR 0:30  
2= 50 /̊66˚

TIME:

New:                Lid:100˚C    
 ABCD               Vol: 20µL
1= 92.0˚ FOR 0:30  
2= 50 /̊66 ,̊ 0:30

OK?      No   Option
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Select “Yes” to enter the step into memory and proceed to the next step; select “No” to reject or edit  
the current step. To preview, select Option, then Preview. Preview gives the calculated temperature for 
each row.  

Editing a Gradient Step

To edit a gradient step, select Edit from the Main Menu. The program will be displayed as follows:

Use the «Select» keys to scroll to the step you want to edit and press «Proceed». At this point you will 
be given the option to INS (Insert a step before the selected step), DEL (delete the highlighted step), 
EDIT (the cursor will move over the various fields you have entered for temperature and step duration, 
both of which can be reentered), and OPTION (more on these options later). In order to edit the gradient 
step, highlight Step 2 and select «Proceed». Next, select EDIT. The cursor keys can be used to move 
between the lower temperature limit, the higher temperature limit, and the time hold. Key in the new 
values, then press «Proceed». 

Using the Gradient Calculator 

Following the analysis of a completed PCR protocol, you want to discern the exact temperature at which 
a particularly successful reaction was run. To recreate the gradient, select the Tools command from the 
Main Menu and then press the  «Proceed» key. You will see a list of Tools features:

ROW A= 66.0˚   o o o o o o       
        B= 64.9˚    o o o o o o 
        C= 62.8˚    o o o o o o 
        D= 59.9˚    o o o o o o 
        E= 56.3˚    o o o o o o 
        F= 53.4˚    o o o o o o 
        G= 51.2˚    o o o o o o            
        H= 50.0˚    o o o o o o

New:          Lid:100˚C     
ABCD          Vol: 20µL
1= 92.0˚ FOR 0:30  
2= 50 /̊66 ,̊ 0:30

TOOLS:   
LAST RUN 
DEFAULT SETTINGS 
SELF TEST 
GRADIENT CALCULATOR 
VERSION 
CONTRAST

	 Creating Programs
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Select Gradient Calculator  and press the «Proceed» key. You will be asked to enter the LOWER TEMP 
˚C. Enter lower limit temperature of the gradient using the number keys and then press the «Proceed» 
key. You will then be asked to enter the UPPER TEMP ˚C. Enter the upper temperature for the gradient 
using the number keys and «Proceed» key. The following screen will be displayed:

Press «Proceed» to return to the Main Menu.

Entering a GoTo Step

When programming the MJ Mini cycler, the option to include a GoTo step, becomes available only 
after a temperature step has been included. In other words, a GoTo step cannot be the first step of 
a protocol. To enter a GoTo step, select GoTo from the Enter Menu. The first GoTo  screen will be 
displayed:

The last line of the screen allows entry of the number of the step the program should cycle back to. 
Enter the number of the step the program should cycle back to (1 is used in this example) and press 
«Proceed». A line allowing an additional number of cycles to be entered will be displayed:

ROW A= 66.0˚   o o o o o o 
        B= 64.9˚    o o o o o o 
        C= 62.8˚    o o o o o o 
        D= 59.9˚    o o o o o o 
        E= 56.3˚    o o o o o o 
        F= 53.4˚    o o o o o o 
        G= 51.2˚    o o o o o o 
        H= 50.0˚    o o o o o o

New:          Lid:100˚C 
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO
 
GOTO STEP:

New:          Lid:100˚C 
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1 

ADDTNL CYCLES:
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Enter the additional number of times the program should cycle back to the step (3 is used in the 
example below). Press «Proceed». The number of additional cycles will be included in the protocol and a 
confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»: 

n  	 Yes accepts the step and options for the next step in the protocol (TEMP, GRAD, GOTO, END). 
n  	 No allows reentry of the step number and number of additional cycles.

Entering the End Step

To enter the End step, select End from the Enter Menu. The single End screen will be displayed:

This screen automatically enters “End” on the next line of the screen, next to a step number, and 
displays a confirmation menu for the step on the last line of the screen.

Select one of the displayed choices, then press «Proceed»: 

n  	 Yes accepts the step, stores the program, and displays the Main Menu or a folders menu.
n  	 No displays the Enter Menu so that additional steps can be added.

If you have created custom folders for your programs (see chapter 8), choosing Yes brings up a screen 
listing the folders:

 

Select the folder you want to store the program in, then press «Proceed». The program will be stored 
in the folder, and the Main Menu will be displayed. If all programs are stored in the same main folder, 
pressing “yes” will save the program and bring you back to the Main Menu.

New:          Lid:100˚C     
ABCD          Vol: 20µL
1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1, 3 TIMES 
 
OK?      No

New:          Lid:100˚C   
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1 
 4= END
OK?      No

SAVE ABCD IN:
<MAIN>  

<FOLDER2>

	 Creating Programs
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Modifying a Program Step with the Options
The Options Menu is accessible from the confirmation menus of temperature steps. To access the 
Options Menu, select Option from the confirmation menu of a temperature step, then press «Proceed». 
The Options Menu will be displayed on the bottom line of the screen: 

n  	 Inc modifies a temperature step with an increment option. An increment option allows a progressive 
increase or decrease of temperature each time the step is executed in a GoTo cycle. 

n  	 Ext modifies a temperature step with an extend option. An extend option allows a progressive  
lengthening or shortening of hold times each time the step is executed in a GoTo cycle. 

n  	 Rate modifies the thermal ramping speed for protocols that require less than maximal speed of  
temperature change.

n  	 Beep modifies a temperature step, causing the machine to beep when a specified target  
temperature is reached.

Entering an Increment Option

To enter an increment option, select Inc from the Options Menu for a temperature step, then press 
«Proceed». The first Inc screen will be displayed:

The temperature step being modified appears on the bottom line of this screen. The plus sign means 
that the screen is set up to enter a progressive increase in temperature per cycle. Press the «-» key to 
switch to a minus sign, allowing entry of a progressive decrease in temperature. Press «-» to change 
back to a plus sign.

New:          Lid:100˚C   
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1 
 4= END
OK?      No

New:          Lid:100˚C   
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1 
 4= END
OK?      No
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Enter the numerical value of the temperature increase or decrease (1.2 is used in the example below). 

Press «Proceed». The Inc value will be included in the protocol, and a confirmation menu will be 
displayed on the last line:

 Select one of the displayed choices, then press «Proceed»:

n  	 Yes accepts the Inc value and displays the Enter Menu again. Use the Enter Menu to enter the next 
step in the program.  

n  	 No allows reentry of the Inc value. 

n  	 Option displays the Options Menu again. Use the Options Menu to enter another option for the step.

Entering an Extend Option

To enter an extend option, select Ext from the Options Menu of a temperature step, then press 
«Proceed». The first Ext screen will be displayed:

Similar to the increment option, the temperature step being modified appears on the bottom line of this 
screen. The plus sign means that the screen is set up to enter progressive lengthening of hold time. 
Press the «-» key to switch to a minus sign, allowing entry of a progressive shortening of hold time. 
Press «-» to change back to a plus sign.

Enter the numerical value of the increase or decrease in hold time.

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30
 
 
˚C / CYCLE + 1.2

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30
 
 
˚C / CYCLE + 1.2

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
 
 
SEC / CYCLE:  +

	 Creating Programs
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Note: You may only use whole numbers here (1 is used in the example below):

Press «Proceed». The Ext value just entered will be incorporated into the protocol, and a confirmation 
menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

n  	 Yes accepts the Ext value and displays the Enter Menu again. Use the Enter Menu to enter the next 
step in the program.  

n  	 No allows reentry of the Ext value. 

n  	 Option displays the Options Menu again. Use the Options Menu to enter another option for the step.

Entering a Rate Option

To enter a rate step, select Rate from the Options Menu. The first Ramp screen will be displayed:

The bottom line of this screen allows a ramp rate (in degrees Celsius per second) to be entered for the 
step. Use the keyboard to enter any rate up to 2.5˚C/sec (1.0˚C/sec is used in the example below):

 

New:          Lid:100˚C     
ABCD          Vol: 20µL 
1= 92.0˚ FOR 0:30  
2= 50.0˚ FOR 0:30 
 
 
SEC / CYCLE:  +

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
    +   1 SEC/ CYCLE  
 
OK?      No   Option

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
 
 
˚C / SECOND:
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Note:   If a ramp rate faster than the cycler’s maximum rate of heating and cooling is entered, the 
maximum rate will be used. 

Press «Proceed». The ramp rate will be incorporated under the temperature step is modifies and a 
confirmation menu will be displayed on the last line: 

 
Select one of the displayed choices, then press «Proceed»: 

n  	 Yes accepts the step and displays the Enter Menu again. Use the Enter Menu to enter the next step 
in the program. 

n  	 No allows reentry of the ramp rate and finish temperature. 

Entering a Beep Option

To enter a beep, select Beep from the Options Menu for a temperature step, then press «Proceed». The 
word “Beep” will be displayed under the temperature step, and a confirmation menu will be displayed on 
the last line:

Select one of the displayed choices, then press «Proceed»:

n  	 Yes  accepts the Beep option and displays the Enter Menu again. Use the Enter Menu to enter the 
next step in the program. 

n  	 No cancels the Beep option.  

n  	 Option displays the Options Menu again, if a temperature step is being modified. Use the Options 
Menu to enter another option for the step.

New:          Lid:100˚C     
ABCD          Vol: 20µL 
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
 
 
˚C / SECOND:

New:          Lid:100˚C 
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
    RAMP AT 1.0 /̊SEC 
 
OK?   YES   No

New:          Lid:100˚C 
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= 50.0˚ FOR 0:30 
    BEEP 
 
OK?      No   Option

	 Creating Programs
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Revising During Programming
To change values in a program that you are entering, follow the procedures described below. This 
editing method should be used to change just a few values at a time. To make many changes, or to 
delete or add entire steps, use the Edit mode (see chapter 7).

To Change the Last Value Entered or Menu Option Chosen

Press «Cancel». The choice just made will be cancelled, so that another value may be entered or another 
menu option chosen. Press «Proceed» after changing a value, so that the program will accept it.

To Change Values for Earlier Steps in the Program

While creating a program, you may move the cursor between fields by using the «Select» keys. This will 
allow you to edit temperature or time hold values in previously entered steps. Position the cursor on any 
step number and press «Cancel». The previously entered value will be deleted and you may enter a new 
value for that field. Press «Proceed» to continue programming.

In order to change the type of step that you want in the protocol (e.g., changing a Gradient step to a 
standard Temperature step), you must first delete the step you wish to replace and then subsequently 
insert the new step in its place as demonstrated below. 

Move the cursor to the number of the step you wish to remove, then press «Proceed». You will be 
presented with the Edit Menu options:

At this point, you may choose to delete the gradient step and replace it with a temperature step. Use the   
«Select» keys to scroll through the options and with DEL selected, press «Proceed». The step will be 
deleted and subsequent steps renumbered.

Press the «Select» keys to scroll through the program again and reinsert a Temp step by selecting the 
second step by highlighting the step number (2 in the example) followed by pressing «Proceed».

 

New:          Lid:100˚C ABCD          
Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1, 25 TIMES 
 4= END 
INS   DEL   EDIT   OPTION

New:          Lid:100˚C  
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= GOTO 1, 25 TIMES 
 3= END 
 
Press ENTER to edit
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You will be presented with the following options: INS, DEL, EDIT, and OPTION. Select the INS option to 
insert a step before the GoTo step. 

 

 
Select Temp and then enter the temperature and time hold fields as previously described in this chapter.

Deleting a Program
To delete the program: Position the cursor on any step number and press «Cancel». A cancellation 
confirmation screen will be displayed and you will be asked whether or not you wish to save these 
changes:

Select No, then press «Proceed». The program will be deleted, and the Main Menu will be displayed.

Keeping a Permanent Record of Programs
Occasionally in the course of repairing a defective thermal cycler, it is necessary to replace the chip that 
stores all custom user protocols. To avoid losing your protocols in such an event, always maintain an 
up-to-date record of them. 

New:          Lid:100˚C 
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= TEMP GRAD GOTO 
 3= GOTO 1, 25 TIMES 
 4= END 
Press ENTER to edit

New:          Lid:100˚C     
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= 50 /̊66 ,̊ 0:30 
 3= GOTO 1, 25 TIMES 
 4=  
Save changes? YES   No

New:          Lid:100˚C 
ABCD          Vol: 20µL
 1= 92.0˚ FOR 0:30  
 2= TEMP GRAD GOTO 
 3= GOTO 1, 25 TIMES 
 4= END 
Press ENTER to edit

	 Creating Programs
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Selecting a Heated Lid Option

The Heated Lid

The heated lid of the Alpha™ unit reduces condensation of water vapor on the upper surface of reaction 
vessels and eliminates the need for mineral oil or paraffin as a vapor barrier. Normally when a reaction 
is heated, vapor forms and condenses on the cooler upper surfaces of the vessel. Such condensation 
can adversely affect a reaction, because as water is lost the reaction solution becomes more 
concentrated. The heated lids maintains a higher temperature in the upper part of reaction vessels, 
which keeps water vapor from condensing.

Constant Mode

Programming the heated lid on the MJ Mini thermal cycler occurs in Constant Mode. In Constant 
Mode, one lid temperature value is set and the lid maintains that temperature constantly (unless the 
block temperature goes below ambient temperature, in which case the lid shuts off ). Constant Mode 
can be used in special cases, such as when you want the lid temperature to be set below the highest 
temperature in the cycling protocol (see below). The default temperature setting in Constant Mode is 
100°C.

Choosing a Lid Temperature

One might expect that using a high lid temperature is always desirable, to ensure that no condensation 
occurs. But in some circumstances, if the lid temperature is too high, it can increase the temperature 
of the reaction. Optimizing lid temperature therefore requires finding a balance between preventing 
condensation and raising reaction temperature. The optimal lid temperature for a given experiment will 
be affected by the reaction volume and the height of the vessel, specifically the amount of surface area 
that rises above the heated block. For tall vessels that have a large surface rising above the heated 
block, the greater potential for condensate formation dictates that lid temperatures should be higher. 
When using low-profile vessels with reaction volumes approaching the maximum for the vessel (e.g. 
50–100 µl in 96-well plates; 15–30 µl in 384-well plates), the proximity of the reaction solution to the 
lid means lid temperatures should be lower. For very small reaction volumes (<5 µl) the need to limit 
condensation generally outweighs potential lid effects on reaction temperatures, so the lid temperature 
should be higher. 

Note: When using 0.5 ml reaction vessels, we recommend a heated lid temperature of 110˚C.
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Editing a Stored Program
The editing tools, available through Edit on the Main Menu, make it easy to extensively edit stored 
programs by

n  	 Changing individual values in program steps
n  	A dding new steps
n  	 Deleting steps
n  	A dding options to temperature steps

Note: The editing tools do not include a renaming function. To create a new program from a stored 
program, begin by copying the program and saving it with a new name, see “Copying a Program” 
(Chapter 8).

Note: If you only need to change the lid temperature or the sample volume, you may do this at the start 
of any standard run. 

Initiating Editing

To initiate editing, select Edit from the Main Menu, then press «Proceed». One of two types of screen 
will be displayed, depending on whether your programs have been stored in the <MAIN> folder or in 
custom folders.

If all programs have been stored in <MAIN>
The screen will list the contents of <MAIN>:

Select the program to be edited, then press «Proceed». 

If programs have been stored in custom folders 
The screen will list all the folders residing in the machine on the left-hand side. As you move your cursor 
over the list of folders, a list of programs that resides in each folder is displayed on the right screen:

Edit:              PROGRAMS
<MAIN>  

iPRF8kb 
		      iPRF15kb 
		      iTAQ-FST 
		      LONG-2

Edit:              PROGRAMS

<FOLDER1>  iPRF8kb 
<FOLDER2>  iPRF15kb
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Select the folder containing the program you wish to edit, then use the right «Select» key to move the 
cursor to the right-hand menu in order to scroll through the list of programs located within that folder. 
Select the program to be edited (iPRF1kb is used in the following and all succeeding examples in this 
chapter), then press «Proceed». 

In either instance, after you press «Proceed», the first editing screen will be displayed (see next section).

Tip: To retain the original version of a program, copy the program (see “Copying a Program,” chapter 8), 
and then edit the copy.

Editing the Program

The first editing screen displays the lid temperature, sample volume and program step. 

Use the «Select» keys to scroll up and down through the program. The cursor will progressively move to 
the step number and the individual values for each step. 

To change an individual value in a step, position the cursor on it and type the new value, then press 
«Proceed». The new value will be displayed on the screen. To cancel a change, press «Cancel» followed 
by «Proceed». The original value will be restored.

To add or delete a step, or to modify a step with an option, position the cursor on the step number, then 
press «Proceed». The Edit Menu will be displayed for that step:

n  	 INS allows a step to be added before the highlighted step.

n  	 DEL deletes the highlighted step. 

n  	 EDIT positions the cursor over the various fields of the selected step so that the values may be 
changed. 

n  	 OPTION allows an option to be added to the highlighted step if it is a temperature step.

Edit:          Lid:  
iPRF1kb     Vol: 20µL  
 1= 95.0˚ FOR 0:30 
 2= 95.0˚ FOR 0:01 
 3= 72.0˚ FOR 0:10 
 4= GOTO 2, 35X 
 5= 72.0˚ FOR 0:15

Edit:          Lid:100˚C 
iPRF1kb     Vol: 20µL  
 1= 95.0˚ FOR 0:30 
 2= 95.0˚ FOR 0:01 
 3= 72.0˚ FOR 0:10 
 4= GOTO 2, 35X
  DEL  EDIT  OPTION

Editing Programs
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Inserting a New Step

To insert a new step, select INS from the Edit Menu, then press «Proceed». The Enter Menu will be 
displayed for the new step (a new step 2 is added in the example below):

You may select to insert a Temperature step, a Gradient step or a GoTo step in the program (see 
“Entering the Program’s Steps,” chapter 6). When the step is complete, select Yes from the confirmation 
menu, then press «Proceed». The program being edited will be displayed again, with the new step 
appearing among the listed steps.

Deleting a Step

To delete a step, select Delete from the Edit Menu, then press «Proceed». The step will immediately be 
deleted, and the program being edited will be displayed again, minus the deleted step.

To cancel a deletion, see “Cancelling Editing Changes,” p. 58.

Note: Be careful when using Delete. Once a step has been deleted, it cannot be recovered without 
abandoning all editing changes that have been made in the program. This could be inconvenient if the 
program has been extensively edited.

Editing a Step

Selecting to edit a step allows the fields of that step to be edited in the same manner as if you were 
scrolling through the protocol using the «Select» keys. Pressing «Proceed» will likewise allow you to 
continue to step through all fields in the program.

Adding an Option

To add an option to a step, select Option from the Edit Menu, then press «Proceed». The Option 
Menu will be displayed for the step, and include: step-temperature increments, step-time extensions, 
ramp rates, and beep option. Add the desired option to the step (see “Modifying a Program Step with 
the Options,” chapter 6). When the option is complete, select Yes from the confirmation menu, then 
press «Proceed». The steps of the program being edited will be displayed again, with the new option 
appearing in the list.

Edit:          Lid:100˚C 
iPRF1kb     Vol: 20µL  
 1= 95.0˚ FOR 0:30 
 2= 95.0˚ FOR 0:01 
 3= 72.0˚ FOR 0:10 
 4= GOTO 2, 35X
  DEL  EDIT  OPTION
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Editing a Program in Graphical Mode
It is possible to edit a program in graphical mode, however the editing that can be performed is limited to 
changing value fields (such as incubation temperatures, hold times, number of GoTo loops). In graphical 
mode, you are unable to insert or delete steps, nor can you add options to temperature steps. However, for 
changing values in a program’s steps, graphical editing is a rapid way to accomplish this. As mentioned on 
p. 55, saving a stored program under a new name allows you to build a new protocol off an existing one 
without losing the original.

To edit a program graphically, select Edit from the Main Menu. You will be presented with a Text Mode 
display of the protocol steps:

Use the «Select» keys to scroll past the header fields of the lid temperature and the sample volume 
fields. Once the cursor is placed over a step in the protocol, you may use the «Screen» button to display 
the program graphically:

 
Protocols are listed in an abbreviated manner, with each step listed on the left. Use the «Select» keys 
to scroll up and down through the steps. As the cursor moves over the various temperature steps, the 
duration of each step is listed at the top of the second column. When a GoTo step is highlighted, the 
second column displays the step number that the cycler will return to, as well as the number of times 
that this loop will be repeated (see below). As you scroll through the program, certain steps in the 
graphical display become highlighted to show the user what step is being referenced. With GoTo steps, 
the dotted line running under the graphical display becomes animated indicating that this step  
is selected.

Edit:          Lid:  
iPRF1kb     Vol: 20µL  
 1= 95.0˚ FOR 0:30 
 2= 95.0˚ FOR 0:01 
 3= 72.0˚ FOR 0:10 
 4= GOTO 2, 35X
 5= 72.0˚ FOR 0:15

 0:30 
95.0  
95.0  
72.0  
GOTO 
72.0 
4.0             35x 

94.0 	 2, 35x 
95.0  
95.0  
72.0 

 
72.0 
4.0            35x 

Editing Programs
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To change the value of any step, highlight that step and retype the numeric value. Select «Proceed» to 
accept the changes. In order to change the time of a particular step, select the temperature step and 
then use the right «Select» key to move the cursor over the time field. Enter a new time and then press 
«Proceed». With a GoTo step, you can edit both the GoTo step number as well for the number of times 
the loop will be repeated. 

To exit the graphical mode, press the «Screen» key again. You will return to the text display of the 
protocol. From here you can continue to edit the protocol more extensively or you may choose to save 
(or cancel) your edits as described below.

Saving an Edited Program
To save an edited program, use the right «Select» key to scroll to the End step of the program. Position 
the cursor on the number for that step, then press «Proceed». A line allowing the editing session to end 
will be displayed on the last line of the screen:

n	E nd saves the changes and displays the Main Menu. This ends the editing session.
n	 Insert allows another step to be added just before the End step.

Cancelling Editing Changes
To cancel all editing changes made to a program, use the «Select» keys to move the cursor to any step 
number, then press «Cancel». A confirmation screen will be displayed which will ask you whether or not 
you wish to save the changes you’ve made:

 
To cancel your edits, select No then press «Proceed». All editing changes will be abandoned, and the 
Main Menu will be displayed.

Edit:          Lid:100˚C 
BASIC       Vol: 20µl  
 9= 10.0˚C FOREVER 
10= END 
 
 
END  

Edit:          Lid:100˚C 
BASIC       Vol: 20µl  
 9= 10.0˚C FOREVER 
10= END
 
 
Save changes?  No
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Locating a Stored Program
Many of the utilities on the MJ Mini cycler (accessible by selecting Files or Tools from the Main Menu) 
require you to locate a program stored in the machine. The actions necessary to do this depend on 
whether your programs have been stored in the <MAIN> folder or in custom folders.

If all programs have been stored in <MAIN>:  

The screen will list all the programs that <MAIN> contains:

Select the desired program from this list.

If programs have been stored in custom folders: 

The screen will list all the folders residing in the machine on the left side of the screen. As you scroll 
through the list of folders (by using the «Select» keys), a list of programs that reside in each folder is 
displayed on the right:

With the appropriate folder on the left side of the screen selected, use the right «Select» key to move the 
cursor to the second column and toggle up and down to select the appropriate program name, then 
press «Proceed».

File Utilities
Use these utilities, available from the Files Menu, to accomplish the following tasks:

n	 Create new folders in which to store programs
n	S ecure, delete, or rename existing folders 
n	 Copy, delete, or rename existing programs
n	 Move a program between folders

Copy:      	    <MAIN> 
_iPRF1kb	     LONG-2 
iPRF8kb         LONG-3 
iPRF15kb	     NEST PR2 
iTAQ-FST       NEST PR3

Copy:      
 

<FOLDER1>  iPRF8kb 
<FOLDER2>  iPRF15kb
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To display the Files Menu, select Files from the Main Menu, then press «Proceed»:

Creating a Folder

The MJ Mini cycler can each hold programs in a number of folders, including the <MAIN> folder. New 
programs are placed in the <MAIN> folder by default unless a different folder is specified.

To create a folder, select NEW from the Files Menu, then press «Proceed». A naming screen will be 
displayed:

Name the folder, using the instructions found under “Naming the Program” in chapter 6, then press 
«Proceed». The name will be assigned to the new folder, the folder will be stored, and the Main Menu 
will be displayed.

Assigning a Password to a Folder

Protocols in a password-protected folder cannot be edited, renamed, or deleted, nor can new protocols 
be placed in the folder without the password. Users without knowledge of the password can still run, 
copy, and view a program.

Note: A password cannot be assigned to the <MAIN> folder.

To assign a password to a folder, select SECURE from the Files Menu, then press «Proceed». A list of 
all folders in the machine will be displayed. Select the desired folder (other than <MAIN>), then press 
«Proceed». The password assignment screen will be displayed:

<FOLDERS>  PROGRAMS 
             COPY 

SECURE       MOVE 
DELETE        DELETE 
RENAME      RENAME

New Folder:

Name: 

Secure: <FOLDER1>

New password:

Using the Utilities
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Valid passwords consist of numbers up to four digits long. For passwords of three digits or less, press 
«Proceed» after the password has been entered. Passwords four digits long will be automatically 
accepted as soon as the last digit is typed, and the Main Menu will be displayed. 

Passwords can be changed at any time. Follow the steps described above to select the desired folder, 
then press «Proceed». A screen asking for the old password will be displayed:

Enter the old password. Again, if the password is less than four digits in length, press «Proceed» after 
entering the final digit of the password and you will be brought to the password assignment screen. If 
the password is four digits long, the password will automatically be accepted when the fourth digit is 
entered and the password assignment screen will appear. Enter the new password as described above. 
The new password will be assigned to the folder, and the Main Menu will be displayed again.

Deleting a Folder

A  folder must be empty before it can be deleted. After all programs have been moved or deleted from 
the folder, select Delete from the left side of the Files Menu, then press «Proceed». A list of all folders 
in the machine will be displayed. Select the folder to be deleted, then press «Proceed». A confirmation 
screen will be displayed:

Select Yes, then press «Proceed». The folder will be deleted, and the Main Menu will be displayed. To 
cancel the deletion, press «Cancel», or select No and press «Proceed».

Secure: <FOLDER1>

Old password:

Delete folder: 
<FOLDER1>

Erase folder?  No



63In the U.S., call toll free at 1-800-4BIORAD (1-800-424-6723)  |  Visit on the Web at www.bio-rad.com

Renaming a Folder

To rename a Folder, select Rename from the left side of the File Menu, then press «Proceed». Select the 
Folder to be renamed and press «Proceed». A naming screen will be displayed:

Note: The <Main> folder cannot be deleted.

Name the new folder (see “Naming the Program,” chapter 6), then press «Proceed». The folder will be 
renamed and the Main Menu will be displayed. 

Copying a Program

The copy utility copies a program and gives the copy a new name. Copies can be placed in the original 
folder or a new one. 

To copy a program, select Copy from the Files Menu, then press «Proceed». Locate the program to 
be copied (see “Locating a Stored Program,” p. 60), then press «Proceed». If more than one folder of 
programs is present in the machine, a screen allowing you to specify the folder to which the program 
will be copied is displayed:

Select a destination folder to copy the program, then press «Proceed». A naming screen will be 
displayed:

Name the copied program (see “Naming the Program,” chapter 6), then press «Proceed». The program 
will be copied to the specified folder under the new name, and the Main Menu will be displayed.

Rename: FOLDER1

New name: 

Copy CUSTOM1 to:
<MAIN>
<FOLDER1>
<FOLDER2>

Copy CUSTOM1 to:

    New Name:
    

Using the Utilities
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Moving a Program

To move a program, select Move from the Files Menu, then press «Proceed». Locate the program to be 
moved (see “Locating a Stored Program,” p. 60), then press «Proceed». A screen listing all folders will be 
displayed. Select the folder the program should be moved to, then press «Proceed». The program will 
be moved to the new folder, and the Main Menu will be displayed.

Deleting a Program

To delete a program, select Delete from the Files Menu, then press «Proceed».  Locate the program to 
be deleted (see “Locating a Stored Program,” p. 60), then press «Proceed». A confirmation screen will 
be displayed: 

Select Yes, then press «Proceed». The program will be deleted, and the Main Menu will be displayed.  
To cancel the deletion, press «Cancel», or select No and press «Proceed».

Renaming a Program

To rename a program, select Rename from the File Menu, then press «Proceed». Locate the program  
to be renamed (see “Locating a Stored Program,” p. 60), then press «Proceed». A naming screen will  
be displayed:

 
Name the new program (see “Naming the Program,” chapter 6), then press «Proceed». The program will 
be renamed and stored, and the Main Menu will be displayed. 

Delete: ABCD
Delete program?
    
      No

Rename: CUSTOM1

New name: 
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Tools Utilities
Use these utilities, available under Tools, to accomplish the following tasks:

n	 View the last program run on the instrument
n	 View and/or change the default settings of the heated lid
n	 Perform a self test
n	U se the gradient calculator
n	 Check the software version of the instrument
n	 Change the contrast of the instrument screen

Viewing the Last Program Run

To view the last run that was performed on the MJ Mini thermal cycler, select Tools from the Main Menu, 
then press «Proceed»:

A list of all Tool Utilities is displayed. Highlight Last Run and press «Proceed». A screen will be displayed 
with information relevant to the last run:

Included are the program name, the settings for the heated lid (in the example above, 100 is the 
programmed lid temperature (in ˚C) and 30 is the block temperature at which the heated lid turns off-see 
below), the sample volume, the duration of the protocol and whether any errors were encountered. In 
addition, the last line of the screen displays the instrument software version. 

To return to the Main Menu, press «Proceed».

      TOOLS: 
 

DEFAULT SETTINGS 
SELF TEST 
GRADIENT CALCULATOR 
VERSION 
CONTRAST

  LAST RUN:  INCUBATE 
       HOTLID:  100,30 
     VOLUME:  20 
    ELAPSED:  10:19 
     ERRORS:  None 
 SOFTWARE:  v.1.1A

Using the Utilities
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Changing the Default Settings of the Heated Lid

From the Tools Menu, select Default Settings and press «Proceed». You will be presented with the 
following screen:

You can change the temperature of the heated lid as well as the minimum block temperature below 
which the heated lid will automatically turn off. Following a run, when the block is cooling to a low-
temperature final incubation, there is no need to maintain a heated lid since evaporation is no longer  
an issue. 

On this same screen, you may set the default sample volume of the reactions that you wish to run in 
the thermal cycler. You do not need to change this value each time you run a protocol with a different 
sample volume — whenever you create a new program, or decide to run a program that is stored on 
the thermal cycler, you will be asked to input your sample volume. The volume set in the Default Setting 
screen will appear. 

To change any of the values on this screen, use the «Select» keys to move the cursor over the 
appropriate field and enter a new value. Pressing «Proceed» will accept the value and move the cursor 
to the next field. Repeatedly pressing «Proceed» will move the cursor over all three fields and will return 
you to the Main Menu. 

If you have incorrectly entered a value, you may hit the «Cancel» key to clear the field and start again. If 
you have already pressed «Proceed» and moved past the field where you incorrectly entered a value, 
exit the Default Settings menu by entering «Proceed» several times until the Main Menu is displayed, and 
then select the Tools utility and reenter the Default Settings menu.  

Performing a Self Test

The self test utility drives the instrument through a rapid battery of tests to ensure that the heat block 
and other components of the instrument are functional. In order to perform a self test, simply select the 
Self Test option from the Tools Menu. Upon completion of the self-test, the Main Menu is displayed. If 
the instrument displays an error or failure message, you should contact Bio-Rad technical support. 

Gradient Calculator

The Gradient Calculator tools allows users to visually recreate the temperature gradient that was used in 
a gradient cycling reaction. From this, users can learn the exact annealing temperature that resulted in a 
successful amplification reaction. 

To visualize the temperature gradient, select the Gradient Calculator option from the Tools Menu. The 
first screen will ask you to enter the low-end temperature for the gradient.

DEFAULT SETTINGS:

Lid Target:       
Turn off Below:  30˚C 
Sample Vol:      20µL
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Enter the lower temperature (keeping in mind that the lowest value for the gradient is 30˚C) and press 
«Proceed». You will then be asked to enter the upper temperature for the gradient: 

Enter the lower temperature (keeping in mind that the highest value for the gradient is 90˚C and that the 
difference between the upper and lower temperature limits cannot exceed 16˚C) and press «Proceed». 
The following screen will display the temperature used in each row of the sample block. The top row 
corresponds to the back row of the sample block while the bottom row represents the front row of the 
block.

By noting at which temperature successful reactions were run at, users are able to convert gradient 
programs to non-gradient programs by using the temperatures in subsequent runs.

GRADIENT CALCULATOR:

LOWER TEMP ˚C: 

GRADIENT CALCULATOR:
LOWER TEMP ˚C: 50.0˚ 

UPPER TEMP ˚C:

ROW A= 57.0˚    o o o o o o 
    B= 56.5˚    o o o o o o 
    C= 55.6˚    o o o o o o 
    D= 54.3˚    o o o o o o 
    E= 52.8˚    o o o o o o 
    F= 51.5˚    o o o o o o 
    G= 50.5˚    o o o o o o 
    H= 50.0˚    o o o o o o

	U sing the Utilities
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Determining the Software Version Number

At times it is necessary to determine which version of software is installed on your MJ Mini cycler  
(e.g., to report a problem to Bio-Rad technical support). To do this, select Version from the Tools Menu, 
then press «Proceed». The current version number will be displayed:  

The top line reports the software version number (1.1Ci in the example). The other four lines refer to the 
eight “pages” that the software has been broken into and their associated versions (Ci in the example).

Bio-Rad periodically updates the software to incorporate new features. Most upgrades are available 
free of charge for units under warranty and may be installed into a MJ Mini cycler electronically from a 
desktop computer. Contact your Bio-Rad sales representative or an authorized distributor for details. 
Occasionally upgrades may require a hardware change. These upgrades require return of the cycler to 
Bio-Rad or an authorized distributor. 

Changing the Contrast of the LCD Display

You may change the contrast of the LCD display. In order to do so, select Contrast from the Tools 
Menu, then press «Proceed». When you are presented with the Contrast Control screen, you may 
use the right «Select» key to increase the LCD screen contrast and the left «Select» key to decrease 
contrast. Once the display has been optimized, press «Proceed» to accept the changes or «Cancel» to 
reject these changes. Pressing either «Proceed» or «Cancel» will bring you back to the Main Menu.

VERSION:  1.1Ci 
 CTRL Ci   EXEC Ci 
 EDIT Ci   COMM Ci 
 FILE Ci   ERRS Ci 
 PORT Ci   GRPH Ci
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Cleaning the MJ Mini Thermal Cycler

Cleaning the Chassis and Block

Clean the outside of the thermal cycler with a damp, soft cloth or tissue whenever something has been 
spilled on it or the chassis is dusty. A mild soap solution may be used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or a 1:100 dilution of bleach in water. 
If using bleach, swab wells with water afterward to remove all traces of bleach. Clean spilled liquids out 
of the block as soon as possible; dried fluids can be difficult to remove. Do not clean the block with 
caustic or strongly alkaline solutions (e.g., strong soaps, ammonia, bleach at a higher concentration 
than specified above). These will damage the block’s protective anodized coating, possibly causing 
electrical shorting.  

If you use oil in the block (a practice not recommended by Bio-Rad; see “Using Oil to Thermally Couple 
Sample Vessels to the Block,” chapter 4), clean the wells whenever the oil has become discolored or 
contains particulate matter. Use a swab to determine whether cleaning is needed. Clean the block with 
95% ethanol as described above. Oil buildup must be prevented. Old oil harbors dirt, which interferes 
with vessel seating and diminishes thermal coupling of sample vessels to the block. 

Caution: Do not pour any cleaning solution into the block’s wells and then heat the block, in an attempt 
to clean it. Severe damage to the block, the heated lid, and the chassis will result.

Cleaning the Air Vents

Clean the air intake and exhaust vents with a soft-bristle brush, a damp cloth, or a vacuum cleaner 
whenever dust is visible in them. The air intake vents are located on the bottom and on both sides 
of the machine; the air exhaust vents are located on back sides (see figs. 3 and 4). If these vents 
become clogged with dust and debris, airflow to the sample block’s heat sink is hampered, causing 
performance problems related to overheating. The air intake vents are particularly likely to collect dust 
since their holes are much smaller than those of the air exhaust vents.

Tip: To prevent problems with overheating, institute a regular program of checking for dust buildup.

Cleaning Radioactive or Biohazardous Materials Out of the Block

When cleaning machines that have been running radioactive or biohazardous reactions, consult your 
institution’s radiation safety officer or biosafety officer regarding cleaning methods, monitoring, and 
disposing of contaminated materials.
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Changing the Fuses
The circuits in the MJ Mini cycler are protected by two fuses (6.3 A fast-acting, 5 x 20 mm). When a fuse 
blows, the thermal cycler immediately shuts down and cannot be turned back on. The machine records 
the event as a power loss, so if a protocol is running when a fuse blows, the machine will resume the 
run when the fuse is replaced and power restored (see “Resuming a Protocol After a Power Outage,” 
chapter 5).

Warning: The MJ Mini cycler incorporates neutral fusing, which means that live power may still be 
available inside the unit even when a fuse has blown or been removed. Never open the thermal cycler 
base. You could receive a serious electrical shock. Opening the base will also void your warranty.

1. 	Disconnect the power cord from the back of the instrument. Move the power switch to the “--” (off) 
position. 

2. 	Remove both fuses and replace them with new ones (it is impossible to visually determine which fuse 
is blown). You may, however, test the fuses with an ohmmeter to determine which is defective and 
replace just that one.

3.	 Reconnect the power cord. 

	 Maintenance



Visit on the Web at www.bio-rad.com  |  In the U.S., call toll free at 1-800-4BIORAD (1-800-424-6723) 72



Troubleshooting10

		  73

Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                 74



Visit on the Web at www.bio-rad.com  |  In the U.S., call toll free at 1-800-4BIORAD (1-800-424-6723) 74

Error Message Probable Cause Action

Running: A/C POWER FAILED 
CYCLE X STEP Y RECOVERED 
AT ZZ.Z° PRESS PROCEED TO 
CONTINUE

Displayed when a machine running a 
protocol has been turned off, either 
intentionally or due to a power outage, 
and then turned on again.

No action is necessary. Protocol resumes 
running when power is restored. Results 
may or may not be affected, depending 
on whether power failed early or late in 
the protocol, and whether the power 
was restored before the sample cooled 
excessively.

ALL BLOCK SENSORS HAVE 
FAILED PLEASE RETURN TO BIO-
RAD FOR SERVICE

None of the temperature sensors are 
working, so the protocol was terminated.

Contact Bio-Rad Laboratories.

ALPHA UNIT HAS OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Alpha unit has exceeded its maximum 
temperature or sensor has a malfunction 
and is not measuring temperature 
accurately, so the protocol was 
terminated.

Contact Bio-Rad Laboratories. 

FAILURE OF HS/PS SENSOR 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Both heat sink and power supply 
sensors have failed, protocol was 
terminated.

Contact Bio-Rad Laboratories.

FAILURE OF PREHEATING LID 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Lid sensor has failed during lid preheat, 
protocol was terminated.

Contact Bio-Rad Laboratories..

FAILURE OF REAR/FRONT BLK 
SENSOR PLEASE RETURN TO 
BIO-RAD FOR SERVICE

Failure means that the sensor was 
deemed short, open or had changed 
more than 3°C in a 50 ms period and 
that this condition was present for more 
than 2 seconds.

Contact Bio-Rad Laboratories.

FAILURE OF HEATSINK SENSOR 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE 

Failure means that the sensor was 
deemed short, open or had changed 
more than 3°C in a 50 ms period and 
that this condition was present for more 
than 2 seconds.

Contact Bio-Rad Laboratories.

FAILURE OF AMP SENSOR 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Amp sensor failed. Failure means that 
the sensor was deemed short, open or 
had changed more than 3° C in a 50 
ms period and that this condition was 
present for more than 2 seconds.

Contact Bio-Rad Laboratories

FAILURE OF PS SENSOR PLEASE 
RETURN TO BIO-RAD FOR 
SERVICE

Machine is not getting enough air or air 
being taken in is warmer than 31°C.

Contact Bio-Rad Laboratories.

HEATSINK HAS OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Machine is running a protocol consisting 
of many cycles of only a few seconds 
each.

Make sure machine gets enough air and 
that temperature of air being taken in is 
31°C or cooler. Correct air supply problems 
and run protocol again. If error message 
persists, contact Bio-Rad or your local 
distributor.

HEATSINK HAS OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Machine is running a protocol consisting 
of many cycles of only a few seconds 
each.

Contact Bio-Rad Laboratories to discuss 
protocol.

HEATSINK HAS OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Sensor malfunction has allowed base to 
heat block over its maximum allowable 
temperature, triggering automatic 
protocol shutdown.

Unit needs servicing, contact Bio-Rad 
Laboratories to discuss protocol.

HEATSINK IS OVERHEATING 
CHECK AIR FLO

See causes for “HEATSINK HAS 
OVERHEATED.”

See actions for “HEATSINK HAS 
OVERHEATED.”

Error Messages
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Error Message Probable Cause Action

MEMORY IS CORRUPT! Rarely seen message indicating that 
memory has been corrupted.

Unit needs servicing, contact Bio-Rad or 
your local distributor.

MEMORY IS NEARLY FULL Protocol memory is nearly full. Deleted unused protocols and folders from 
memory. Reduce size of stored programs 
by using GoTo and the Inc and Ext options.

NO MEMORY AVAILABLE All available protocol memory storage 
has been filled.

Deleted unused protocols and folders from 
memory. Reduce size of stored programs 
by using GoTo and the Inc and Ext options.

POWER SUPPLY OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Machine is not getting enough air or air 
being taken in is warmer than 31°C.

Make sure machine gets enough air and 
that temperature of air being taken in is 
31°C or cooler. Correct air supply problems 
and run protocol again. If error message 
persists, contact Bio-Rad Laboratories.

POWER SUPPLY OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Machine is running a protocol consisting 
of many cycles of only a few seconds 
each. Heatsink does not have time 
to dissipate heat generated by rapid 
cycling. Eventually its maximum 
allowable temperature is exceeded and 
the protocol was terminated.

Contact Bio-Rad Laboratories to discuss 
protocol.

POWER SUPPLY OVERHEATED 
PLEASE RETURN TO BIO-RAD 
FOR SERVICE

Sensor malfunction has allowed base to 
heat block over its maximum allowable 
temperature, triggering automatic 
protocol shutdown.

Unit needs servicing, contact Bio-Rad 
Laboratories to discuss protocol.

POWER SUPPLY OVERHEATING 
CHECK AIR FLOW

See causes for “POWER SUPPLY 
OVERHEATED”

Unit needs servicing, contact Bio-Rad to 
discuss protocol. 
See actions for “POWER SUPPLY 
OVERHEATED”

SELFTEST FAILURE PLEASE 
RETURN TO BIO-RAD FOR 
SERVICE

Selftest has failed. Contact Bio-Rad Laboratories.

SLOW BLOCK CYCLING PLEASE 
RETURN ALPHA UNIT SOON

Block has not reached target 
temperature within expected time. Unit 
will begin beeping and will continue to 
beep until target temperature is reached, 
protocol is manually progressed to its 
next step, or protocol is halted. Problem 
often results from machine not getting 
enough air, or taking in air that is warmer 
than 31°C.

Make sure machine gets enough air and 
that temperature of air being taken in is 
31°C or cooler. Correct air supply problems 
and run protocol again. If error message 
persists, contact Bio-Rad Laboratories.

SLOW GRADIENT PLEASE 
RETURN ALPHA UNIT SOON

Block failed to achieve gradient in the 
expected time.

Unit needs servicing, contact Bio-Rad 
Laboratories.

	 Troubleshooting
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2-step Fast PCR protocol using iTaq™  
polymerase

iTAQ-FST

Step	 Temp	 Time

1	 98	 0:30

2	 92	 0:01

3	 70	 0:10

4	GO TO  	 2, 35X

5	 72	 0:15

6	E ND

2-step PCR protocol using iProof™ high 
fidelity polymerase for small, intermediate, 
and long templates

iPRF1kb

Step	 Temp	 Time

1	 95	 2:00

2	 95	 :05

3	 72	 :30

4	GO TO	 2, 20X

5	 72	 10:00

6	E ND

iPRF8kb

Step	 Temp	 Time

1	 95	 2:00

2	 95	 :05

3	 72	 4:00

4	GO TO  2, 20X

5	 72	 10:00

6		E  ND

iPRF15kb

Step	 Temp	 Time

1		  95	 2:00

2		  95	 :05

3		  72	 7:30

4		GO  TO  2, 20X

5		  72	 10:00

6		E  ND	

Standard 2-step PCR protocol

STD-2

Step	 Temp	 Time

1		  95	 4:00

2		  95	 :30

3		  65	 :30

4		GO  TO 2, 30X

5		  4	 ∞

6		E  ND

Standard 3-step PCR protocol

STD-3

Step	 Temp	 Time

1		  95	 4:00

2		  95	 :30

3		  55	 :30

4		  72	 :30

5		GO  TO 2, 30X

6		  72	 7:00

7		  4	 ∞

8		  END

Touchdown PCR protocol

TCHDOWN

Step	 Temp	 Time

1		  95	 4:00

2		  95	 :30

3		  60	 :30

           (Increment -0.5°C/cycle)

4		  72	 :30

5		GO  TO 2, 30X

6		  95	 :30

7		  45	 :30

8		  72	 30

9		GO  TO 6, 30X

10		  72	 7:00

11		  4	 ∞

12		E  ND	
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2-step RT PCR protocol

RTPCR-2

Step  	 Temp	 Time

1		  37	 60:00

2		  95	 5:00

3		  95	 :30

4		  65	 :30

5		GO  TO 3, 40X

6		  72	 7:00

7		  4	 ∞

8		E  ND	

3-step RT PCR protocol
	
RTPCR-3

Step  	 Temp	 Time

1		  37	 60:00

2		  95	 5:00

3		  95	 :30

4		  55	 :30

5		  72	 :30

6		GO  TO 3, 40X

7		  72	 7:00

8		  4	 ∞

9		E  ND	

2-step nested primer protocol

NEST PR2

Step  	 Temp	 Time

1		  95	 4:00

2		  95	 :30

3		  65	 :30

4		GO  TO 2, 40X

5		  72	 7:00

5		  4	 ∞

6		  95	 :30

7		  65	 :30

8		GO  TO 6, 40X

9		  72	 7:00

10		  4	 ∞

11		E  ND

3-step nested primer protocol

NEST PR3

Step  	 Temp	 Time

1		  95	 4:00

2		  95	 :30	  
3		  55	 :30	  
4		  72	 :30	  
5		GO  TO 2, 40X	  
6		  72	 7:00	  
7		  4	 ∞	  
8		  95	 :30	  
9		  55	 :30	  
10		  72	 :30	  
11		GO  TO 8, 40X	  
12		  72	 7:00	  
13		  4	 ∞	  
14		E  ND		

2-step long PCR protocol using  
iTaq polymerase

LONG-2

Step  	 Temp	 Time

1		  95	 4:00

2		  95	 :30

3		  65	 3:00	E xt 15s/
cycle 
4		GO  TO 2, 35X

5		  72	 7:00

6		  4	 ∞

7		E  ND		

3-step long PCR protocol using 
iTaq polymerase

LONG-3

Step  	 Temp	 Time

1		  95	 4:00	

2		  95	 :30

3		  55	 :30

4		  72	 3:00     Ext 15s/cycle

5		GO  TO 2, 35X

6		  72	 7:00	

7		  4	 ∞

8		E  ND						   
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O
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P
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stopping while running  31

S
Safety

general instructions  8
guidelines for safe use  4
warnings  4

Sample block
closing  19
maximum rate of heating and cooling  12
opening  19

Sample vessels
ensuring good thermal contact  22
loading into block  22
sealing
	 reason for  20
	 with Hot Bonnet and Caps/Film  21
	 with oil or wax  20
	 selection  19
	 0.2ml tubes  20
	 0.5ml tubes  20
	 microplates  20
selection chart  23
use of oil to improve thermal contact with  
	 block  22

Self-test  18,66
Setting machine up  14
Specifications  12

gradient specifications  12

T
Temperature control methods

block control  37
calculated control  37
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U
Utilities

file
	 assigning password to folder  61
	 copying a program  63
	 creating a folder  61
	 deleting a program  64
	 deleting a folder  62
	 moving a program  64
	 renaming a program  64
tools 
	 changing the contrast of the LCD  
		  display  68
	 changing the default settings of the heated 		
		  lid  66
	 determining the software version  68
	 gradient calculator  66
	 performing a self test  66
	 viewing the last program run  65

W
Warranties  5

	I ndex
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